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Introduction

CHAPTER

The following three Peregrine products can be configured to work together:
m Network Discovery
m Desktop Inventory

m Desktop Administration

Desktop Inventory collects and maintains an up-to-date view of all
computers in your organization. The product is able to support all inventory
management projects, from the smallest operational requirement, through
to the tactical inventory and the enterprise level strategic solution.

When used with Network Discovery, the process of maintaining an up-to-
date IT asset inventory can be automated.

A flexible web-based User Interface is used to configure schedules for
distribution and execution of scanners, retrieval of scan files, etc. Once
Desktop Inventory has been configured, inventory data is automatically
collected, analyzed and published both as internal reports and through a
well-structured database accessible via ODBC.

Desktop Administration is a remote administration tool for your company's
computers. The Desktop Administration software suite is based on two
principle applications:

® Automatic Administration

= Configure remote computers.
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= Propagate and recover data from remote computers.
= Distribute and deploy software.

= Verify the implementation of internal security rules on the computers
in your IT portfolio.

= Prevent the propagation of a virus by eradicating it on infected
computers and servers.

m Remote Control
= Perform remote administration duties on your servers.
= Resolve problems by taking remote control of an employee's computer.

= Broadcast information rapidly using a message, news, and chat
functions.

There are some steps that you must take to ensure the three products work
well together in your network. Read this chapter as well as Setting up Network
Discovery to work with Desktop Inventory on page 29 to learn the steps
involved.

8 »>Chapter 1—Introduction
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The interaction of the components of Network
Discovery and Desktop Inventory

The following diagram shows at a high level the interaction of the main
components of Network Discovery and Desktop Inventory. You can see what
parts of Desktop Inventory are running inside the Peregrine appliance.
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The Peregrine Appliance

The Peregrine appliance can be made responsible for collecting the scan files
generated by the Scanners and storing them centrally.

The Scanners are distributed to individual computers from the appliance
using the listener. The appliance maintains a schedule dictating which
computers should be scanned and when.

When a particular computer needs to be scanned, the appliance contacts the
Listener on the computer, sends a copy of the appropriate Scanner
configuration file and a copy of the latest Scanner to the computer, executes
it, and retrieves the scan file.

Note: Listener Agents must be deployed to all computers where automatic
scan scheduling and scan file retrieval should take place. See Setting up
Network Discovery to work with Desktop Inventory on page 29 for
information about deploying the Listeners.

Retrieved scan files are stored in a directory on the appliance. A background
process, the XML Enricher, polls this directory for new scan files and
processes them so they can be added to the appliance's inventory database. It
also enriches the scan files with application data and stores these as
compressed XML files accessible from a network share.

The automatic deployment of Scanners

In most cases, the Scanners can be automatically deployed to a computer as
that computer is discovered with Network Discovery, and executed as
needed.

This mechanism makes Scanner deployment an easy task, as opposed to
situations where deployment has to rely on network login scripts or manual
intervention. Thus, the accuracy and completeness of the collected inventory
data can be very high.

Important: Automatic deployment of scanners is supported on all Win32

platforms. Scanners must be deployed by more traditional
means for DOS, UNIX/Linux, and OS/2 platforms.
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Scheduling of scan execution

It is possible to specify a schedule for computer scanning. The schedule serves
at least two purposes.

m First, although the execution of a scan is designed to be as unobtrusive as
possible to the user of a computer, some users do notice and find it
distracting. So scans can be scheduled to run at a time of day that tends not
to conflict with users.

m Second, the accuracy of the inventory depends on the frequency of scan
execution. For example, some users want the data refreshed every week,
others every month. So the frequency of scans can be specified.

Collection and storage of scan files

A Scanner writes a scan file to the local disk of the scanned computer, and the
scan file is transferred to the appliance for storage and processing. There are
a few ways in which the scan file can be transferred:

m The appliance contacts the computer and transfers the scan file from the
computer. This is the typical case for computers that are permanently
connected to the network. The collection of scan files is scheduled and
controlled to minimize impact on the network. For example, you can
specify what times of day are appropriate for scan file collection, how
many files can be transferred in parallel, and how much network
bandwidth scan collection is allowed to consume.

Note: Collection of scan files is decoupled from the execution of a scan. You
can schedule scans for one time of day, but collect the scan files some
time later using a different schedule.

m Some computers, for example laptops, are only occasionally connected to
the network. In this case, the scan file can be transferred whenever that
computer connects. Since the connection speed may be slow and the
connection time short, the transfer mechanism gracefully recovers when
the connection is interrupted and can be resumed when the connection is
re-established.

m Some computers may never be network accessible to the appliance, for
reasons of network topology or security. In this case, it is the responsibility
of the administrator to transfer the scan files from such computers to the
appliance. The appliance supports an SMB network mountable drive for
this purpose. The administrator can simply mount this network drive and
copy as many scan files as required to it.

The Peregrine Appliance < 11
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Once a scan file is transferred to the appliance, it is further processed to
recognize software applications (XML enrichment process) and added to the
inventory information stored in the Inventory Database. The resulting
enriched scan file is stored on the appliance for subsequent access by tools
such as Viewer, Analysis Workbench or Connect-It. This enriched scan file is
always stored in compressed XML format. At most one scan file for each
computer is stored, and the name of the scan file is normally derived from the
Asset Tag uniquely identifying the machine. The enriched scan files are
optionally backed up along with other appliance data.

The Agent

All Peregrine products use the same agent. In Desktop Inventory
documentation, it is called the “Listener Agent.” In Desktop Administration
documentation, it is called the “Agent.”

Each Listener agent originating from a Peregrine appliance will have a
security key from that Peregrine appliance. This means that the Listener
agent will only be able to communicate with that Peregrine appliance. This is
also true of agents originating from the Desktop Administration server, if it
is configured to use security keys. Desktop Administration agents with a
security key can only communicate with that Desktop Administration server.

To use Network Discovery with Desktop Inventory and Desktop
Administration, the security keys must be identical across all products. See
Setting up Network Discovery to work with Desktop Inventory on page 29 for
more information.

The Listener is installed as a service on a remote computer. This service
enables the computer to be securely scanned at any given time. In Windows
NT, 2000, 2003, and XP, a manager can instantly deploy this service on
computers using the QuickDeploy function.

The Listener is able to perform tasks on a computer on behalf of Peregrine
applications.

m The Listener is available on Win32.

m For security reasons, Listener communications are encrypted and
authenticated.

12 »Chapter 1—Introduction
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m The Listener listens and performs requests for Network Discovery. For
example, it can install a Scanner, execute a scan, or transfer a scan file to
the appliance.

m Ifa computer is not connected to the network, the Peregrine appliance is
able to detect when a connection is established by making use of the
Listener agent (the Listener agent sends broadcast packets to the
appliance). Thus the appliance is now able to discover, scan, and collect
scan files from, computers that are only temporarily connected to the
network.

Note: A newly discovered computer cannot be scanned without first
installing the Listener agent.

The Listener component must be installed on every workstation that will be
part of the automatic inventory process. This can be done for Windows NT-
based computers using the QuickDeploy feature, or it may have to be done
manually.

Note: QuickDeploy cannot be used with Windows 95/98/ME.

Note: If you are doing the inventory manually, you do not need the Listener
agent.

Once installed, the Listener is capable of communication with the appliance.
The communication can only be initiated by the appliance. The Listener is
not able to initiate any file transfers, scans, etc.

Further information
For further information about the Listener, refer to Setting up Network
Discovery to work with Desktop Inventory on page 29.

Scan file enrichment

The XML Enricher is a process that runs in the background on the appliance.
It automatically adds application data to new scan files, and then saves them
in the xsf format. This process is called scan file enrichment.

Further information

For further information about the XML Enricher, refer to The XML Enricher
on page 57.
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2 Sharing Security Keys between Network

cnarrer DiSCOVEry and Desktop Administration

The goal is to make Network Discovery, Desktop Inventory, and Desktop
Administration work together.

As discussed in Introduction on page 7, all the Peregrine products use the
same agent. By default, the Network Discovery Listener agent uses security
keys. The Desktop Administration agent can be configured to use security
keys, but the keys are not required for normal operation.

This means that the agents distributed by Desktop Administration may not
have any security keys, or will have different security keys than the agent
distributed by Network Discovery for use with Desktop Inventory.

Also, each Peregrine appliance has its own security keys. If you have more

than one Peregrine appliance in your network, see Sharing Security Keys
between your Peregrine Appliances on page 25.

Sharing Security Keys between Network Discovery and Desktop Administration < 15
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Desktop
Administration
Manager 1
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L — 4
7
Agent 2 |
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Administration - — 9
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L — 4
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Agent 4 |
L — 4
Peregrine C
Appliance
Agent5 |
L — 4

Note: It is ideal for you to make sure Network Discovery and Desktop
Administration have the same security keys before you deploy any agents
on your network.

Note: If for any reason, you need to have different security keys on your
Peregrine appliances or Desktop Administration servers, contact
customer support for advice on how to proceed.

The only way to copy the security keys from one product to another (or
between Peregrine appliances) is by copying the files (keypriv.key and
keypub.key) from one product onto a new DOS/Windows formatted (3.5
inch, 1.44MB) floppy disk and manually loading the files into the other
product.

The security key files are transferred on a floppy disk for security

reasons. Do not ever transfer the private key over the network in a
non-encrypted format.

16 >Chapter 2—Sharing Security Keys between Network Discovery and Desktop Administration
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There are two procedures described in this section:

m Putting the Peregrine appliance security keys onto Desktop Administration
on page 18

m Putting the Desktop Administration security keys onto the Peregrine
appliance on page 23

If you have deployed agents from Desktop Administration first, then copy
the keys from Desktop Administration onto the Peregrine appliance. If you
have deployed agents from the Peregrine appliance first, then copy the keys
from the appliance onto your Desktop Administration server.

If you have deployed Listener agents from Network Discovery first, and you
want to copy security keys to your Desktop Administration server, you will
need to reinstall the agents already deployed from Desktop Administration.

The Network Discovery Listener agent is a smaller version of the agent from
Desktop Administration. They do not have the same functionality. For
example, you cannot remotely control computers using the Network
Discovery Listener.

For more information on how to set up and use Desktop Administration,

refer to the Desktop Administration Installation Guide and Desktop
Administration User Guide.

17
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Putting the Peregrine appliance security keys onto
Desktop Administration

Copying the Security Key files to a floppy disk

1 Select one Peregrine appliance in your network as the “master” appliance.
You will use the security keys from this appliance to copy to the other
Peregrine appliances in your network.

2 Insert a floppy disk into the disk drive on the “master” appliance.

3 On the “master” Peregrine appliance, access the configuration interface by
connecting a keyboard and monitor directly to the appliance.

4 Login with your configuration password (the default is “Appliance”).

The screen shows the Appliance Management menu:
1) Settings

2) Actions

3) Appliance hardware information

4) Exit and log off

5 Type 2 (or use the arrow keys to move the cursor to 2) and press Enter.

The screen shows the Appliance Actions menu:
1) Return to main menu

2) Appliance shutdown

3) Appliance restart

4) Set time

5) Synchronize time

6) Add licenses from floppy

7) Copy listener security keys to floppy

8) Copy listener security keys from floppy

9) Check CD

6 Type 7 (or use the arrow keys to move the cursor to 7) and press Enter.

The screen shows the following text:
Mounting floppy disk...

Copying files...

Copied file “keypriv.key”.

Copied file “keypub.key”.

Copied file “response.ans”.
Unmounting floppy disk...

Press Enter to continue.

7 Press Enter.
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8
9

H W

Exit the program.

Remove the floppy disk from the drive.

Create a new Remote Control Certificate in Desktop Administration using

the Security Keys

Insert the floppy disk into your Desktop Administration server.

Login to Desktop Administration (Start >Programs > Peregrine > Desktop

Administration Console).

Click Open, then click OK on the splash screen.

Click Tools > Actions > Create a Remote Control Certificate.

The Manager Authentication window appears, and you will now go through
a setup wizard. The following table shows the basic setup. If you have already
configured Desktop Administration, you may need to have different settings
in some of the wizard screens. Refer to your Desktop Administration
documentation for more information.

Wizard Page Action

Manager Authentication Click Next.
NT Security Click Next.
InfraTools Servers Click Next.

Broadcast Detectors

Select all three options:

m Use the broadcast detector

m View the properties of the broadcast detector
m Edit broadcast detector

Click Next.

Direct Accesses

Click Next.

Default Logon Parameters

Select “Ask for this password” if you want to be
asked for a password every time you log on to a
remote workstation through Remote Control.

Click Next.

Default Control Options Click Next.
Default Control Rights Click Next.
Permission to modify Click Next.

default parameters

Putting the Peregrine appliance security keys onto Desktop Administration
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Wizard Page Action

Validity Change the date if you want a longer license period.
Click Next.

Add Security Keys Select the keypriv.key file on your floppy disk.
Click Next.

Generate Certificate Save the new Certificate as certificate.cfg
Click Finish.

Set up the Certificate using the Private Key in Peregrine Remote Control
1 Login to the Peregrine Remote Control Manager.
2 Click File > Start the Configuration Wizard.

The Configure InfraTools Manager wizard appears, and you will now go
through a setup wizard.

Wizard Page Action
Configure InfraTools Select “Use another certificate” and choose the
Manager “certificate.cfg” file that you have already created.
Click Next.
InfraTools agent version Select “All versions.”
Click Next.
End of Configuration Click Finish.

Configure the response.ans file for QuickDeploy of the Agents

The response.ans file is used by QuickDeploy to deploy listeners to remote
workstations with the appropriate configuration settings. Response.ans
contains the public key (in an encrypted format).

1 Insert the floppy disk into your Desktop Administration server.

2 In order to have the complete agent required with Desktop Administration,
you must alter the text of the response.ans file.

a Open response.ans in a text editor such as Notepad.
b Find the line with this information:
Packages=iftlsnr

¢ Change the line to read as follows:

20 » Chapter 2—Sharing Security Keys between Network Discovery and Desktop Administration
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Packages=iftlsnr,iftmsg,iftrc,iftsys
d Save the file onto the disk with the same filename.

3 In Windows Explorer, copy the file and also save it to the following two
locations:

\Program Files\Peregrine\Remote Control\deploy\generic

\Program Files\Peregrine\Desktop Administration
Server\depot\deploy\generic

4 Exit the program.

Install the security key into the Server Configuration

The file you altered in the previous procedure must now be installed in the
Desktop Administration Server Configuration program.

1 In Windows, click Start >Programs > Peregrine > Desktop Administration
Server > Server Configuration Tool.

The Server Configuration Tool appears.

*. Configure 'Peregrine b = |EI|1|
File Service Server Help
Information |
- ¥ Service
A Statuz Started
= B Configure the database
Server D FELM
Connection name flumP D&
Login Admin
- ¥ Server information
¥ Databaze flumP D&
¥ Mavimum number of slaves |20
¥ Number of curert slaves 2
€ File depot C:/PROGRA™1/PEREGR™1/DESKTO...
€9 Frivate key <none:
¥ Default server 1
¥ Managed instances 1]
o Running targets 1]
o W aiting targets 1]
¥ Broadeast listering addresses|
i Mumber of store: 0

2 Click Server > Modify the private key.

Putting the Peregrine appliance security keys onto Desktop Administration < 21
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*. Configure 'Peregrine Desktop ) [=] ]

File Service Server Help

iomaton [ modication of the prvate ke NS =]
- %%3:\;99 Identity:
tatuz .
= B Configure the data F|Ie.| g
Server D T
Connection na
Login Admin
- ¥ Server information
¥ Databaze flumP D&
¥ Mavimum number of slaves |20
¥ Nurber of curert slaves 2
€ File depot C:/PROGRA™/PEREGR™1/DESKTO. .
€ Frivate key <none:
¥ Default server 1
¥ Managed instances 1]
o Running targets 1]
o W aiting targets 1]
¥ Broadeast listening addresses|

Delete | Cancel |

3 Click the “browse” icon, and choose the private key file from the floppy disk.
4 Click OK.

5 Exit the program.
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Putting the Desktop Administration security keys onto
the Peregrine appliance

Putting the Desktop Administration keys onto the Peregrine appliance
Insert a floppy disk into your Desktop Administration server.

In Desktop Administration, go to Tools > Actions > Generate a double
encryption key.

A wizard appears. From here, you can save the public and private security key
files.

" Wizard: 'Generate a double encry 10l =|
Generate a double encryption key

|dentity associated with the key

Length of the key

[1024 |

Frivate key backup file:

| keyprivkey ol Browse icons
\ Public key backup file:

| ckeypub key Ei/

| Cancel |

< Brevious | Tewt > | Eirizh

3 Enter an identity (name) for the keys.

O 00 N O

10

Click the “browse” icon for each file, and choose the floppy drive as the place
to save the public and private security keys.

Click Finish.

This process may take a few seconds.

Wait for the system to confirm that the files have been saved to the floppy.
Remove the floppy disk from the Desktop Administration server.

Put the floppy disk in the Peregrine appliance drive.

On the Peregrine appliance, access the configuration interface by connecting
a keyboard and monitor directly to the appliance.

Login with your configuration password (the default is “Appliance”).

Putting the Desktop Administration security keys onto the Peregrine appliance < 23
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The screen shows the Appliance Management menu:
1) Settings

2) Actions

3) Appliance hardware information

4) Exit and log off

11 Type 2 (or use the arrow keys to move the cursor to 2) and press Enter.

The screen shows the Appliance Actions menu:
1) Return to main menu

2) Appliance shutdown

3) Appliance restart

4) Set time

5) Synchronize time

6) Add licenses from floppy

7) Copy listener security keys to floppy

8) Copy listener security keys from floppy

9) Check CD

12 Type 8 (or use the arrow keys to move the cursor to 8) and press Enter.

13 The screen shows the following text:
Mounting floppy disk...
Copying files...
Copied file “keypriv.key”.
Copied file “keypub.key”.
Unmounting floppy disk...
Press Enter to continue

14 Press Enter.
15 Exit the program.
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3 Sharing Security Keys between your

cnaerenPeregrine Appliances

Each Peregrine appliance is shipped with a unique Listener agent security
key. If you are aggregating multiple appliances, and using Desktop Inventory,
you should make sure all your Peregrine appliances have the same security

keys.

Peregrine
Appliance 1

1
Agent 2 |
L — 4
- 7

Peregrine

Appliance 2 |Agent3 |

Peregrine
Appliance 3

Sharing Security Keys between your Peregrine Appliances < 25
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This can be accomplished in a few simple steps:
m Copy the security keys from one appliance onto a floppy disk.
m Copy those security keys from the floppy to the other appliances

Copying the Security Key files to a floppy disk

1 Select one Peregrine appliance in your network as the “master” appliance.
You will use the security keys from this appliance to copy to the other
Peregrine appliances in your network.

2 Insert a floppy disk into the disk drive on the “master” appliance.

3 On the “master” Peregrine appliance, access the configuration interface by
connecting a keyboard and monitor directly to the appliance.

4 Login with your configuration password (the default is “Appliance”).

The screen shows the Appliance Management menu:
1) Settings

2) Actions

3) Appliance hardware information

4) Exit and log off

5 Type 2 (or use the arrow keys to move the cursor to 2) and press Enter.

The screen shows the Appliance Actions menu:
1) Return to main menu

2) Appliance shutdown

3) Appliance restart

4) Set time

5) Synchronize time

6) Add licenses from floppy

7) Copy listener security keys to floppy

8) Copy listener security keys from floppy

9) Check CD

6 Type 7 (or use the arrow keys to move the cursor to 7) and press Enter.

The screen shows the following text:
Mounting floppy disk...

Copying files...

Copied file “keypriv.key”.

Copied file “keypub.key”.

Copied file “response.ans”.
Unmounting floppy disk...

Press Enter to continue.

7 Press Enter.
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8 Exit the program.
9 Remove the floppy disk from the drive.

Copying the Security Key files onto the other appliances

Note: Repeat the following steps on all other Peregrine appliances on your
network.

Copying a security key overwrites the one existing on the
appliance. If any agents have been deployed using this security key,
you will no longer be able to communicate with them.

1 Insert the floppy disk into the disk drive on the Peregrine appliance.

2 On the Peregrine appliance, access the configuration interface by connecting
a keyboard and monitor directly to the appliance.

3 Login with your configuration password (the default is “Appliance”).

The screen shows the Appliance Management menu:
1) Settings

2) Actions

3) Appliance hardware information

4) Exit and log off

4 Type 2 (or use the arrow keys to move the cursor to 2) and press Enter.

The screen shows the Appliance Actions menu:
1) Return to main menu

2) Appliance shutdown

3) Appliance restart

4) Set time

5) Synchronize time

6) Add licenses from floppy

7) Copy listener security keys to floppy

8) Copy listener security keys from floppy

9) Check CD

5 Type 8 (or use the arrow keys to move the cursor to 8) and press Enter.

The screen shows the following text:
Mounting floppy disk...

Copying files...

Copied file “keypriv.key”.

Copied file “keypub.key”.
Unmounting floppy disk...

Press Enter to continue
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Note: The “response.ans” file is not copied. The Peregrine appliance will
automatically regenerate this file.

6 Press Enter.
7 Exit the program.
8 Remove the floppy disk from the drive.
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with De

CHAPTER

sktop Inventory

This chapter provides a step-by-step approach to getting started when
using Network Discovery with Desktop Inventory and Desktop
Administration.

Some of the steps are carried out on the Windows workstation running
Desktop Inventory and some on the Peregrine appliance running
Network Discovery. We have indicated this where applicable.

Prerequisites

What you should have completed by now:

Setup the Peregrine appliance successfully for Network Discovery and have a
populated Network Map.

Installed Desktop Inventory on a workstation (see the Desktop Inventory User’s
Guide for more information on how to do this).

Installed a valid Desktop Inventory license (see the Desktop Inventory Installation
and Upgrade Guide for more information on how to do this).

Shared the security keys between the Peregrine Appliance and Desktop
Administration (see Sharing Security Keys between Network Discovery and Desktop
Administration on page 15).

There are many default configurations already set up for you, and it would
be wise to choose some of these to get started.
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The automatic deployment of Scanners

First, you must make sure the Listeners have been deployed to the computers
in your network.

Then, the Scanners can often be automatically deployed as computers are
discovered on the network, and executed as needed.

This greatly reduces the effort involved in maintaining an inventory. Since
the process is automated and does not rely on network login scripts or
manual intervention, accuracy and coverage is increased.

Automatic deployment of scanners is supported on all Win32 platforms.
Scanners must be deployed by other means for DOS, UNIX/Linux, Winl6
and OS/2 platforms, if applicable.

You will need to know what devices are in your network to follow this
procedure. You will be giving Network Discovery a list of IP addresses for it
to find and from which to collect scan data.

You cannot automate the deployment of DOS, UNIX/Linux,
Winl16 and OS/2 Scanners. You will need to deploy these
manually.

Steps

Use the following checklist to track your progress setting up Network
Discovery, Desktop Inventory, and Desktop Administration.

m Step 1: Tell Network Discovery which version of Desktop Inventory scanners
you are using on page 31.

m Step 2: Map a drive from Windows workstation to the appliance shared
directories on page 32.

m Step 3: Make Network Discovery and Desktop Inventory ‘aware’ of each other
on page 34.

m Step 4: Add a Scanner Account on the appliance (optional) on page 36

m Step 5: Run Scanner Generator, generate and validate your Scanner
configuration files (Windows workstation and appliance) on page 37.

m Step 6: Add or define a Scanner Property Group on the appliance on page 38.
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Step 7: Define a Listener Property Group on the appliance on page 43.

Step 8: Apply the Scanner and Listener property groups with one or more IPv4
ranges (appliance) on page 44.

Step 9: Submit and activate your changes on page 46.

Step 10: Deploy the Listeners to your workstations on page 47.

Step 1: Tell Network Discovery which version of Desktop Inventory
scanners you are using

This feature allows you to tell Network Discovery which version of Desktop
Inventory you are using (either 7.3.1 or 8.0, earlier versions of Desktop
Inventory are not supported).

There are two possible scenarios in which you would use this feature:
m Upgrading to Network Discovery 5.2 on page 31
m New Network Discovery 5.2 Installation on page 31

Note: Regardless of your installation scenario, Network Discovery 5.2
requires a Desktop Inventory 8.0 .SAI file. If you are upgrading to
Network Discovery 5.2, this means that the XML Enricher will be disabled
until you manually re-enable it, presumably after upgrading your SAI and
re-installing it on the appliance.

Upgrading to Network Discovery 5.2

If you upgrade to Network Discovery 5.2, the default setting will be to work
with scanners from Desktop Inventory 7.3.1. If you are also upgrading to
Desktop Inventory 8.0, you should change this default setting.

New Network Discovery 5.2 Installation

If you have a new Network Discovery 5.2 installation, the default setting will
be to work with scanners from Desktop Inventory 8.0.

When you decide to change this setting to be 7.3.1, you must do so
before you set your network configuration. You will lose all of your
scanner configurations (all will be reset to the default settings, see
Step 6: Add or define a Scanner Property Group on the appliance on
page 38) if you change this setting when Network Discovery is
already running in your network.
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Note: If you have already deployed 8.0 scanners on machines in your
network, and decide to change this setting to work with 7.3.1 scanners,
your 8.0 scanners will not revert.

To tell Network Discovery which version of Desktop Inventory scanners
you are using:

1 Click Administration > System preferences > Scanner Version.
2 Ifyou want to change the default setting, make your selection.
3 Click Change.

Use wersion 7.3.1 instead of version 8.0 scanners . ¢ Default Mo
& Custom: @ Yes © No

Change |

Step 2: Map a drive from Windows workstation to the appliance
shared directories

Before implementation, you will need to make the Shared directories share
on the appliance accessible to Windows.

To map a drive letter to the shared directories share on the appliance:

1 Open Windows Explorer on your workstation. Click Start > Programs >
Accessories > Windows Explorer.

2 Click Tools > Map Network Drive.
3 In Drive, select the drive letter to map to the shared directories.

4 In Folder, type the server and share name of the appliance, in the form of
x:\\<appliance_IP_Address>\share. For example enter:

x:\\172.22.5.2\share

Note: You can use the domain name or the IP address of the appliance.

To reconnect to the mapped drive every time you log on, check the
Reconnect at logon check box.
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Support of Network Share
This share is used for several purposes:

m Scan files for unconnected desktops are deposited to the share for
subsequent processing.

m Enriched scan files are accessed from the share by other applications such
Viewer, Analysis Workbench and Connect-It.

m Scanner configuration files produced by Scanner Generator are deposited
here.

The valid login name and password of a user account on the appliance is
required to access the share. Connecting to a share is supported on the
following platforms: Windows 98, ME, NT4 SP3+, 2000, 2003, XP and any
other platform supported by a Samba SMB Client.

For Windows 98 and Windows ME there are some other restrictions:

m The Windows 98/ME login name must be the same as the account name
used to access the appliance.

m When accessing the shared directory, you need to use the DNS name of the
Peregrine appliance (i.e. you cannot use the IP address).
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Step 3: Make Network Discovery and Desktop Inventory ‘aware’ of

each other

The activation of the interoperability between Network Discovery and
Desktop Inventory requires several steps.

To make Network Discovery and Desktop Inventory ‘aware’ of each other:
From your management workstation, login to the Network Discovery.
Click Download.

On the Download page, click on the DI-ND.reg file.

The “File Download” dialog appears.

Click Open to run the file.

The Registry Editor prompt appears.

5 Click Yes to enter your information into the registry.

Click OK to confirm the action.

7 Copy the license.reg file sent to you by Peregrine to the following directory

on the appliance:

share\license\incoming

Note: The license.reg is the license file that you received with the Desktop
Inventory software.

This enables the Desktop Inventory license and options in Network
Discovery.

You will now have access to Desktop Inventory related options in the
Network Discovery user interface.
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8 Now launch the Desktop Inventory Viewer and check the About box. You
will see that the Network Discovery aware entry indicates that
interoperability has been enabled.

About Automation |

. Peregrine

SYSTEMS.

Desktop Inventory

Wigwer
Copyright [C] 2003 Peregrine Systems, Inc.
w7.3.0 Build 2638, 12 Jun 2003

Licenzed by: Peregrine Systems
Mumber of devices: 10,000
Metwork Discovery aware: Yes
Licence expires on: Mever
Total Spstem Memany: 261 E1EKD
Available System Memory: 9,052 Kb

The two applications can now work with each other.

9 On the appliance, go to Status > Current Settings > Installed Licenses to
verify that the Desktop Inventory licenses are in place.

Note: The licenses for using Desktop Inventory with Network Discovery will
be maximized at the number of devices Network Discovery is licensed for.
For example, if you have a 10,000 user license for Desktop Inventory and

a 5000 device license for Network Discovery, then only 5000 licenses will
be valid here.
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Step 4: Add a Scanner Account on the appliance (optional)

O 00 N &0 1 A W N =

If you will be using delta scanning, and transmitting your scan files over
HTTP, you will need to setup a Scanner account on the Peregrine appliance.

The Scanner account is only used to establish a connection to the appliance
when there are no Listeners (for example, when scanning UNIX machines).
You will set up the account in Network Discovery, and then you will enter the
same user name and password in the Scanner Generator (see The Scanner
Options page on page 87).

To set up the Scanner account:

Click Administration > Account administration > Add an account.
Enter an account name, and click Add Account.

Click Modify account capabilities.

Select the “Scanner” account type.

Enable Web access.

Click Modify Capabilities.

Click Modify account password.

Enter the password (twice) and click Modify Password.

You are finished. There is no need to configure any account properties for
this account.
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Step 5: Run Scanner Generator, generate and validate your
Scanner configuration files (Windows workstation and appliance)

Two screens are different when you use the Scanner Generator in the
appliance mode. These are the first screen and the last screen and are
described in Scanner Generator on page 77.

For the purpose of this procedure, so you can become familiar with the
process, you can also use the sample Scanner configuration files supplied on
the appliance. These configuration files have already been validated.

Alternatively, follow the steps below to create a new Scanner configuration.

To start the Scanner Generator on the Windows Workstation:

» Click Start > Programs > Peregrine > Desktop Inventory 8.0 > Scanner
Generator.

The Scanner Generator appears.

Create a scanner configuration file called Test and validate it.

Further information

See the Scanner Generator chapter in the Desktop Inventory User’s Guide for
instructions on how to generate and validate Scanner configuration files.
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Step 6: Add or define a Scanner Property Group on the appliance

A Scanner Property Group is a named group of Scanner-related settings.
These settings can later be applied to one or more IP ranges of devices to scan
(see Step 8: Apply the Scanner and Listener property groups with one or more
IPv4 ranges (appliance) on page 44).

These settings allow you to define the following:
m Assign a name and description to the property group.
m Choose which Scanners should be run on which devices in your network.

For example, if you only want to scan Windows devices in your network,
you can choose to only deploy the Win32 Scanner. This setting will allow
you to deploy the correct Scanner to any particular IP range in your
network. Here are the possible options:

Scanner Configuration File for:

= Win32

= HP/UX

= Linux

n AIX

= Solaris
m Choose the maximum bandwidth allowed for scanner deployment.
m Choose when:

= Scanners are deployed or upgraded

= Scanners are run

m Scan files are retrieved

To define a Scanner property group:

1 Click Administration > Network Configuration > Scanner Property Groups
> Add a scanner property group.
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The Add a Scanner Property Group page appears:

MName: |Examp|e

Description; [Example text

Select for all scanners: | <inherit> |
or select individually:
Win32 scanner [<inherit= =]
HP/UX scanner [<inherit= =]
Linux scanner: [<inherit= =]
AlX scanner [<inherit= =]
Solaris scanner: [<inherit= =]
Bandwidth Threshald: © Set & Inherit
(I T
Frequency: " Set & Inherit
Weeks: [0 Days: |0 Hours: [0
Scanner upgrade schedule: |<inherit> | J
Scanner run schedule: | <inherit> | J
Scan file download schedule: | <inherit= | J

Submit |

2 Give the property group a name. For example, ‘Example Scan’

3 Add a description if you want to.

Choosing which Scanners are applied to the devices in your
network

You can select Scanner configuration files:

m For all Scanners in one go (Win32, HP/UX, Linux, AIX, Solaris).

m For the different platforms individually. To do this, select individual
Scanner Configuration files for each of the platforms. For example, you
may want to select the following:

Scanner type Scanner configuration

Win32 Scanner Test

HP/UX Scanner Hardware only
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Scanner type Scanner configuration
Linux Scanner Hardware only

AIX Scanner Default

Solaris Scanner Hardware only

We have supplied some predefined scanner configuration files. These are
accessible from the drop down Select from the Scanners list:

m <None> - No Scanner configuration file will be associated with the
Scanner Property Group.

m <inherit> - You can inherit Scanner configuration settings from the
parent IP range.

m <default> - This configuration uses the default inventory settings of the
Scanner Generator.

m <fastsw> - This configuration does a fast software scan of your machines
- no signaturing, file identification, etc.

m <hwonly> - This configuration does a hardware scan only of your
machines

In addition, the drop down lists also show any configuration files that you
have validated. Your Test configuration file will also appear in the list if you
carried out the Scanner configuration file validation step on page 37
correctly.

To choose which Scanners are applied to the devices in your network:

» Select it from the drop down list, either for all Scanners or for Scanners
individually.

Setting the bandwidth threshold

In order to avoid congestion of low-bandwidth links, it is possible to set a
bandwidth threshold here. The bandwidth threshold specifies the maximum
bandwidth that will be used when communicating with a single device for
sending the Scanner or retrieving the scan file. There are two options - you
can Set a threshold or Inherit one.

To set the bandwidth threshold:

» Select one of the two options:
a Set - You can enter the bandwidth threshold in Kb/s Mb/s, Gb/s
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b Inherit - The bandwidth threshold will be inherited from its parent IP
range. This is primarily of interest in networks where a large number of IP
ranges need to be configured. In this case the setting for many IP ranges
can be changed by changing the parent setting if all of the child IP ranges
have used inherit.

Examples of bandwidth thresholds have been given below:
m Over a dial up line - 5Kb/s

m OveraLAN - 1 Mb/s

m Over a WAN - 10 Kb/s

Note: The default is 0/sec which means there is no limit.

Setting the frequencies of scans

It is the job of scheduling to ensure that the population is re-scanned at
regular intervals to ensure the inventory is reasonably up to date at all times.

These settings allow you to choose when scanners are run, collected, or
upgraded in your network.

To set the Frequency of the scan:

» The frequency setting determines how often the scan will take place. You can
select from two options:

a Ifyou select the Set button, you can enter the frequency parameters in
Weeks, Days and Hours.

b If you select the Inherit button, the frequency setting will be inherited
from it’s parent IP range.

Setting scan schedule properties

Some predefined scanner schedules have been supplied. These are accessible
from the drop down lists:

m <None> - No scan schedule will be set for the property.

m <Inherit> - You can inherit Scanner configuration settings from the
parent IP range.

m <All the time> - The scan schedule property will be in effect all the time.

m <Weekends> - The scan schedule property will only be in effect on
weekends.
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m <Not during working hours> - The scan schedule property will only be in
effect outside working hours.

m <working hours> - The scan schedule property will only be in effect
during working hours (i.e. betweeen 9 am and 5 pm).

To set the Scanner upgrade schedule:
This setting determines how often the Scanners will be upgraded.
» Select an option from the Scanner upgrade schedule drop down list.
To set the Scanner run schedule:
This setting determines when the Scanner can be run.
» Select an option from the Scanner run schedule drop down list.
To set the Scan file download schedule:

This setting determines when the Scan file will be retrieved from the
workstation to the appliance.

» Select an option from the Scan file download schedule drop down list.
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Step 7: Define a Listener Property Group on the appliance

A Listener Property Group is a named group of Listener-related settings.
These settings can later be applied to one or more IP Ranges of devices to scan
(see Step 8: Apply the Scanner and Listener property groups with one or more
IPv4 ranges (appliance) on page 44).

To define a Listener property group:
1 Login to Network Discovery.

2 Click Administration > Network Configuration > Listener Property Groups
> Add a Listener Property Group.

MName: |

Description: |

Farts onwhich to transmit to the listener agent. & Default:
€ Custom: |

Submit |

3 Give the property group a name. For example, ‘Windows Workstations’
4 Add a description if you want to.

5 Inthe Ports on which to transmit to the listener agent field, select Default to
use the default port (1738) or Custom to enter the port on the workstation
that the Listener will be transmitted manually.

6 Once you have done this, click the Submit button. A summary is displayed.

7 Review the changes and summary and scroll to the bottom of the page. If you
are happy with the settings, click the Activate changes button. See page 46 for
an explanation of the purpose of the Activate changes page.
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Step 8: Apply the Scanner and Listener property groups with one

or more IPv4 ranges (appliance)

In this step we are specifying what to scan and where, by applying the
previously defined Property Groups to a set of IP addresses.

In this step, we use Property Sets, which are named sets of Property Groups.
You can either use an existing Property Set or define a new one consisting of
different Property Groups.

You should have a good idea of what devices are in your network.

Apply the Scanner and Listener property groups.
1 Click Administration > Network Configuration > Add IPv4 range.

IPw4 Range & Add by interval € Add by subnet

Starting IPvwd Address: I IPwd Address: I
Ending IPvd Address: I Metmask: I

Location of range i tree & Diefault

© Custom
Froperty Set/Group Choose existing Property |Select Property Set/Group | J

Set/Groug:

or, if there is not one that matches your requirements...

Add new Property Set:
Name: l—
Deseription: |
Metwork property groups: |<inherit> j J
Cotmmunity property groups: |<inherit> j J
Srcanner property groups: |<inherit> j J
Listener property groups: | <inharit» j J

Submit |

2 Select the Add by interval option.

3 Enter the Start IP and End IP addresses for the range of computers you want
to scan.

4 In the Property Set/Group drop down list scroll down to the Scanner Group
in the list.

5 Now do one of the following:
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a Select the new Scanner Property Group you created in Step 6: Add or
define a Scanner Property Group on the appliance on page 38. (Example
Scan) and click ... to inspect a summary of the property group. To return
to the Add an IPv4 range page click the Go back to Add an IPv4 Range
link.

Note: You can select one of the many default selections provided. If none of
them suits your needs, you can select “global” for now, and then create
your own configuration that would be best suited to your IP range.

b Give the IPv4 range a name and description (optional) and specify the
settings for the various property groups. You can select one of the many
default selections provided.

- Network property groups
- Community property groups
- Scanner property groups - select Example Scan from the drop down list.

- Listener property groups - select Deploy Listener to Windows
Workstations from the drop down list. This is the Listener property group
you created on page 43.

6 Click the Submit button when you are finished. A screen appears, showing
you the options of where your range can fit into the entire network. Typically,
the first option (selected by default) is the best, but choose another option if
you feel it is necessary.

The Submit button adds this change to a list of changes, but does
not activate the changes. You can make more changes if so
desired and activate them all using Activate Changes as
described in Step 9: Submit and activate your changes.
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Step 9: Submit and activate your changes

Activate your changes
1 Click Administration > Network Configuration > Activate changes.

2 The activate changes page is displayed showing a summary of the changes
you have made.

3 Review the changes and summary and scroll to the bottom of the page. If you
are happy with the settings, click the Activate changes button.

The Activate changes page

The Activate Changes page allows the administrator to review all the changes
that have been made before actually having the changes take effect.

You must activate the changes to the system in order to have the changes take
effect.

You will be told how many potential devices will have to be explored, and
given a minimum exploration time (for example, “at least 33 minutes”).

Also, you will be told of any configuration problems detected. You can ignore
the warnings, but do so at your own risk.

If you decide to implement the changes you have made, activating the
changes will update your network configuration.
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Step 10: Deploy the Listeners to your workstations

The previously discussed settings allow you to choose a listener port on your
desktops, through which the Listener will communicate with the appliance.

The Listener is installed onto the desktops in your network, and can upload
Scanners to desktops, execute them to collect software and hardware
information and download back the scan data to the appliance for detail
inventory of desktops.

For each of the Scanner types you will need a corresponding Listener on the
computers where it will be run in order for Scanners to be scheduled.

Note: There is no Listener for DOS, OS/2, Unix, or Linux - therefore these
Scanners cannot be automated.

Ways of deploying the Listener
m Download the Listener agent from the appliance and manually install it
onto the computer.

m Download the Manager Console and use QuickDeploy to install the
Listener to many computers at the same time.

m You could use login scripts.

m You could also send out a company wide e-mail instruction employees to
visit the download page on the appliance via their web browser and
download and install the listener on their own machine. For this method
to be successful, users should reach it from /download which is not
password protected (/nm/download is password protected).
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Downloading the Listener programs from the appliance
To download the Listener programs from the appliance:
1 Login to the appliance.
2 On Network Discovery, click the Download link. The Download download

page is displayed.
| Fiename | Sze | Desarpon |
agent exe 972 27 kilobytes  Listener agent for Windows
deltascan.pl 372 Kilobytes Sample script to automate delta scans
DIMD reg 475 bytes Registry entry to Enable Network Discovery Awareness features in Desktop Inventory
j2re-1_4_2_03-windows-i586-p.exe 14.52 megabytes Java Runtime Engine for Windows
manader exe 972 27 kilobytes  Windows console for QuickDeploy
IyODBC-3 51.06 exe 73118 kilobytes  MySQL ODEBC driver for MS Windows
MyCODBC-2 51 .06 tar.gz 314 .51 kilobytes  MySQL ODEC driver source code
PeregrineTraphiB b4 1039 kilobytes  Peregring MIB for SNMP Trap notifications
SumRepExample.doc 67 50 kilobytes  Document to create WS Word based reports
SumRepTemplate dot 104.00 kilobytes  Template to create MS Word based reports

3 There are two Listener related files on this page:

File Description
manager.exe The QuickDeploy Console Manager for Windows
agent.exe The Listener Agent for Windows

4 To download a file, click on the file link. A dialog similar to the following is
displayed.

File Download |
“f'ou have chosen to download a file from this location.

listener-hpus.tar. gz from frenchy. matris laran. com

‘what would you like to do with this file?

" Open this fils from its current location

¥ Alwayz ask before opening this type of fils

Qg I Cancel Moare Infa
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5 Select the Save this program to disk option.

6 Navigate to the location where you want to save the file and click Save. The
installation program is saved to the specified location.

Install the QuickDeploy Manager Console

You must have Administrator privileges to be able to install the
Manager Console.

In order to use QuickDeploy on your Windows workstations,
the workstations must have their “Server Properties” enabled.
This setting is enabled by default, but may have been turned off
by an Administrator. Check the status by clicking Start >
Settings > Control Panel > Administrative Tools > Services >
Server.

Note: If a warning message appears saying that your evaluation period has
expired, you can still use QuickDeploy.

The Manager Console enables you to remotely install the Listener Agent
module on one or more Windows computers.

To install the Manager Console on your workstation:

1 Double click on the manager.exe file you downloaded in the previous
procedure. The following dialog is displayed.

InfraTools Web Loader |

4 % Peregrine QuickDeploy Console.

All components required to setup Peregrine QuickDeploy Conzole
will be installed.
Frezz continue to proceed with installation.

Continue | |}

2 Click Continue. The console is installed.
Saving the response.ans file

To function properly, you must copy the response.ans file from the Peregrine
appliance to your newly installed version of QuickDeploy.
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To copy the response.ans file to QuickDeploy:

1 Open Windows Explorer.

2 Access the following folder on your Peregrine appliance:
http://<appliance_IP_address>/download/agent/

3 Right-click on response.ans.

4 Click Save Target As.

5 Save the file to the following location (replacing the file that already exists in
that folder).

Program Files\Peregrine\Remote Control\deploy\generic

6 Exit the program.

Using QuickDeploy from the Manager Console to deploy the
Agent module

To use QuickDeploy from the Manager Console to deploy the Agent
module:

1 From the Workstation where the Manager was installed (see previous
procedure), click Start > Programs > Peregrine > Remote Control >
Manager.

50 > Chapter 4—Setting up Network Discovery to work with Desktop Inventory



Using Network Discovery with Desktop Inventory and Desktop Administration

The Manager Console appears, and then the QuickDeploy wizard is
launched. (If the wizard does not appear, you can click File > Start
Deployment Wizard.)

- Wizard: "QuickDeploy!’, i |EI|1|
Deployment parameters:

Account: ||

Domair: |

Password: |

List of computers for deployment
) Select in an NT domair

® Impart from an MD scan

O Impart fram a file

O Manually enter

Server address |

Account |

Pazsword |

< Brevious | Tewt > | Eirizh | Cancel |

2 The List of computers for deployment setting should be defaulted to Import
from an ND scan. If this is not the case click on this option.

3 Populate the Account, Domain and Password fields. That is, the NT User
having administrative rights on the target computers.

Note: This user should have enough privilege to access the c$ share and run
services on remote computers.

4 Enter the Server address (appliance name or IP address for appliance).
5 Enter the Account login and password for the appliance. For example:
= Account: admin

= Password: password
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6 Click the Next button to continue to the Select machines page of the Wizard.

- Wizard: "QuickDeploy!'. _. ;Iglll
Select machines

Select one or more computers:

£ \workgroup |, Mame £ P + Detection date_ +
PRGN DONTEST 172222233 2000-02-08 09.0¢
LORAM MCARTHUR 172221078 2000-02-08 091"
LORAM OTTOMMETA1 17222148 2000-02-08 0912
PRGN MBEMDER 17222287 2000-02-08 0920
PRGN FrLIM 172221017 2001-02-23 15:0¢
{ |FRGM WwiNIBDEW 172222240 2000-05-18 14:37
PRGN RMCGARRY 172222168 2000-06-16 12:18
PRGN OTTONAPP1 17222178 2000-12-06 13:3¢
WwORKGROUP OTTONDATADT 17222174 2000-12-06 134«
PRGN OTTONEDCA 17222174 2000-12-06 14:07
PRGN OTTONFILEY 17222173 2000-12-06 14:48
IDD_DEVEL IDDSME 172221768 2000-12-06 14:3(
PRGN ROLLINS 172221049 2000-12-1911:4¢
PRGN OTTONEXCT 17222172 2000-12-20 0730
PRGN TIMFITZGERALD 17222265 200103121322
PRGN CHGLUYEN 172.22.257 2001-03-26 1jﬂ
4| »

Select all
< Previous | Tewt > | Einizh | Cancel |

This page presents a list of computers detected on the network and having no
agents.

7 Select the computers on which you want to remotely install the Agent
module.
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8 Click the Next button to continue to the Confirmation page.

- Wizard: "QuickDeploy!', ;Iglll
Confirmation

You are about to deploy the agent on 5 computers. This operation may take
zeveral minutes per computer. Do you want to continue?

DOMTEST
MBEMNDER
FELIM
WINIBDEY
RMCGARRY

< Previous | Mest » | FEinigh | Cancel |

This page lists the names of the computers on which you want to install the
Agent module. Look at the confirmation page to check the list of selected
computers.
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9 Click the Next button to continue to the Start Deployment page.

- Wizard: "QuickDeploy!'. ;Iglll

Start deployment

Meszage Date

9

< Previous | Mest » | FEinizh | Cancel |

10 Click Run to launch the remote installation of an Agent module. The length
of time it takes to deploy the Agent module depends on the number of
computers selected. You can stop the deployment process at any time by
clicking Abort.

Note: We advise you to select a small set of computers to avoid large
processing times and massive error reporting in case invalid information
was provided.

11 Click Finish after the deployment process has terminated. The status bar will
indicate that it is 100% complete.
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Manually installing the Agents from a browser on the local
Workstation

Instead of using QuickDeploy, you can manually install the Agent from a
remote computer.

To manually install the Agents from a browser on the local Workstation:
1 Login to Network Discovery on your local workstation.
2 Click Download.
3 On the Download page, click on the agent.exe file.
The “File Download” dialog appears.
4 Click Open to run the program.
The Web Loader is displayed.

InfraTools Web Loader |

4 % Peregrine Desktop Agent Web Loader.

o sl components required to setup Peregrine Inventary Agent
will be installed.
Click continue to proceed with installation.

LContinue

5 Click Continue.

The Agent is installed on the machine and will have a key
corresponding to the appliance it comes from. Other appliances
will not be able to talk to it. For more information, see Sharing
Security Keys between your Peregrine Appliances on page 25.
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5 The XML Enricher

CHAPTER

The XML Enricher is a process that runs on the Peregrine appliance and
automatically adds application data to scan files. This process is called scan
file enrichment.

When using the XML Enricher on the appliance, it is no longer necessary to
use the Windows-based XML Enricher that is installed with PDI.
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Operating principles

When the XML Enricher is running, it looks for new scan files (xsf, fsf, or dsf
format) in a directory on the appliance every 20 seconds.

When a file is found, it processes the file using SAI (Software Application
Index) application recognition. Information about recognized applications
is added to the file data and a separate <applicationdata> section is added to
the scan file.

At the end of the process, a new enriched scan file in xsf format is created and
the original scan file is deleted (unless you have enabled delta scanning, in
which case the original scan file is moved to the “original” directory). If an
error occurs, the original scan file is moved to a failure directory and is not
deleted.

If an enriched scan file for the same asset already exists, the old
file is overwritten. The XML Enricher does not support the
storing of historical data.

Note: Using the Desktop Inventory Scanner Generator, you can configure
the “delta scanning” feature. Enabled by default, the delta scanning feature
allows you to merge new data in your existing scan files. To disable or
enable this feature, see The Scanner Options page on page 87. For more
information on the feature, see your Desktop Inventory User’s Guide.

During the Enrichment process, the Enricher also prepares the data for the
Inventory Database on the appliance. Within an hour of enrichment, data for
a computer will be available for Reports, Aggregation, etc.

The XML Enricher can also be used to re-enrich scan files that were enriched

previously. This can be useful after applying a significant update to the
application library.
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The XML Enricher directory structure

The enricher uses a directory structure like the following, which resides on

the appliance.

Directory Explanation

\scans The base directory

\scans\deferred The scan file is moved to this location if it is a device
that the Network Discovery side does not know
about yet.

This only happens when a manual scan was done
and copied to the scans\incoming directory.

It eventually gets moved from this directory back to
the scans\incoming directory.

\scans\deferred\firstscan  If the Automatically defer all new scans option
was set (see Configuring the XML Enricher on the
appliance on page 68.) the scan file is not processed.

Instead, it is moved to this directory. Any scan files
in this directory are for the first time a scan file was
seen for a particular computer.

This allows the administrator to review the asset and
application data.

When you are satisfied that the data is ok, you can
move it back to the incoming directory.

Note: New scan files from a computer will not be
processed while a scan file for it exists in this
directory. The existing scan file in this directory
will be overwritten by a new scan file.

\scans\failed The base failure directory. Failed scans are moved to
a sub directory of this.

\scans\failed\corrupt Scans that cannot be read or may not be scan files
are moved here.

\scans\failed\delta If the original scan file is missing or if there is an
error applying the delta scan file to the original one,
the delta scan file will be moved here.

\scans\failed\error When any other error occurs, scan files are moved
here.

\scans\failed\filter The scan ends up here if it has an IP address outside
a range that has been configured to allow scanned
devices.
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Directory Explanation

\scans\failed\licence If too many scans are processed, new scans are
moved here.

\scans\failed\old Scan files that are copied to incoming but are older
than the one already in the database are moved here.

\scans\incoming The incoming directory. The enricher looks for new
scan files here.

\scans\mif The MIF directory. If enabled, MIF files are created
here.

\scans\original This folder is used for delta scanning. It stores copies

of original scan files, which are then used in
conjunction with delta scan files to recreate the new
versions of the scan files. Do not change or move the

contents.
\scans\processed The processed directory. Enriched scan files are
created here.
\scans\processed\[user You can group the scan files based on Hardware
defined] Fields. This is user-defined. Define the settings at

Administration > System preferences > Scan file
management. See Managing Scan Files on page 72.
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Checking the status of the Enrichment process

To check the status of the Enrichment process:

1 Click Status > Appliance Health > Software Environment. The Appliance
Software Environment status page is displayed.

2 Scroll down to the Scan File Processing section.

Oldest unprocessed scan file: s

MNumber of unprocessed scan files: 0

Failures due to stale scan files:

Failures due to insufficient scan licences:
Failures due to IP address based filtering:
Failures due to unreadable scan files:

Failures due to miscellaneous scan file
processing errors:

- 2003-06-

Scan File Processing _| = 141533

Lo T s ' N s Y o
=

This section shows the number of scans waiting to be processed, as well as the
number of scans that failed, grouped by failure reason.

If the number of failed scans is too high, this is indicated by an appliance
Health indicator of Warning or Alarm.

Disk space requirement

You will need to have enough free disk space on the appliance to hold all of
the scan files for your organization. As an estimate, each scan file is 200kB in
size (assuming default Scanner options were used). For example, if you are
licensed for 5000 devices, a minimum of 1GB disk will be used.

Ifyou enable the delta scanning feature (see The Scanner Options
page on page 87), you will need to have twice the disk space
available.

Method 1: To check how much disk space is left on the appliance using the
Device Manager:

1 On the main Toolbar, click Find. The Find panel is displayed.
2 Click the Device icon.

3 Enter the IP address for the appliance (you can also type in nmc) and press
Enter.

4 Double-click on the device listed in the Find panel.
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A Device Manager session opens for the appliance.

5 On the State panel, scroll down to the Disk:/ setting and click on the link.

A 2004-02- Disk { 9852 MB 4835 0f 9882 MB = 2004-02-
231333 48 92% 27 09:59
- 2004-02- Misk: /backup1 1282 GB 06314 0f1282GB= 2004-02-
231333 4.93% 27 09:59
nfa Misk: /backup1 28.09 GB 09156 0f 2809 GB = 2004-02-
326% 27 10:01
nfa sk /backup2 2833 GB 13950f 2833 GB = 2004-02-
.
- 2004-02- Miske N ' Dick
23 13:33 ame. 15
il Disk: Description: f
Units: MB —
haximum value: 9882
IR . o o state|
thresholds: 10% 30 % +
30%50% &
50% 90% ¢
90 % + u
State: -
State time: 3 days 20 hours 28 minutes ago at: Monday, February 23, 2004
133325 EST
Value: 4835 of 988 2 ME = 48.92%
Update time: 2 minutes 32 seconds ago at: Friday, February 27, 2004
095933 EST

6 In the example above, 483.5 of 988.2 MB (48.92%) disk space is being used.

Method 2: To check how much disk space is left on the appliance using the
Hardware Environment status page:

1 Click Status > Appliance Health > Hardware Environment. The Appliance
Hardware Environment status page is displayed.

2 Scroll down to the Disk Utilization section.

hain Partition: 51% -
Boot Partition: 3% -
: I Frimary Data Partition: 11 % - ]
Disk Ltilization Semonder; Dei Periion 139% - 2003-06-13 07:11

Frimary Data Backup Partition: 6% -
Frimary Data Backup Partition: 6% -
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Structure of the enriched xsf file

Scanfile.dtd describes the structure of the scan file in standard DTD format.
By default this file can be found in the following location:

Program Files\Peregrine\Desktop Inventory\8.0.0\Common

Note: The file is a text file, but is easiest to read with an XML reader.

An xsf scan file contains a sequence of elements, each of which have various
attributes. Root elements are:

m <hardwaredata>
m <applicationdata>
m <filedata>

m <storedfiles>

m <configurationdata>

Note to If using Connect-It 3.0.1 or later, use the DTD to describe the format of the
Connect-It scan file to Connect-It.

users

An example of how the data is stored

The following is an example of several sections in an xsf file.

<?xml version="1.0" encoding = "UTF-8" 2>
<inventory codepage="1252" locale="English (United States)" fsfmajorver="7"
fsfminorver="10">

<hardwaredata>
<hwAssetData type="shell">
<hwAssetDescription type="attrib">Dallas (15950 North Dallas Parkway) - -
(Pentium I1l, 448MHz, 256Mb)</hwAssetDescription>
<hwAssetTag type="attrib">000590 </hwAssetTag>
<hwAssetUserLastName type="attrib">tod.brown@peregrine.com</
hwAssetUserLastName>
<hwAssetUserJobTitle type="attrib">Dallas (15950 North Dallas Parkway)</
hwAssetUserJobTitle>
</hwAssetData>
<hwMemoryData type="shell">
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<hwMemTotalMB type="attrib">256</hwMemTotalMB>
<hwSwapFiles type="shell">
<hwSwapFiles_value type="shell_value">
<hwMemSwapFileName type="attrib">C:\pagefile.sys</
hwMemSwapFileName>
<hwMemSwapFileSize type="attrib">203</hwMemSwapFileSize>
</hwSwapFiles_value>
</hwSwapFiles>
<hwDOSMemoryData type="shell">
<hwMemConventional type="attrib">640</hwMemConventional>
</hwDOSMemoryData>
<hwCMOSMemory type="shell">
<hwMemExtended type="attrib">260724</hwMemExtended>
<hwMemCMOSTotal type="attrib">261364</hwMemCMOSTotal>
<hwMemCMOSConventional type="attrib">640</hwMemCMOSConventional>
</hwCMOSMemory>
</hwMemoryData>
</hardwaredata>
<applicationdata>
<recogconfig>
<sai name="C:\Program Files\Peregrine\Desktop
Inventory\8.0.0\Common\User.sai" desc="User SAI File" date="14/04/2004"
type="Editable"/>
<sai name="C:\Program Files\Peregrine\Desktop
Inventory\8.0.0\Common\Master.sai" desc="" date="07/05/2004"
type="Master"/>
</recogconfig>
<application version="6.4.09"
release="6.4"
name="Windows Media Player"
publisher="Microsoft"
language="English"
os="Windows 2000"
type="Interactive Media Tools"
maindir="C:\Program Files\Windows Media Player"
lastUsed="2003-09-26 00:00:00"
versionid="9978"
releaseid="582"
licencedby="11907"
licencedbyrelease="84"
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/>
<application version="6.0 sp1"
release="6.0"
name="Internet Explorer"
desc="Microsoft Internet Explorer"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Web Browsers"
maindir="C:\Program Files\Internet Explorer"
lastUsed="2004-05-05 00:00:00"
versionid="12790" releaseid="131"
/>
</applicationdata>
<filedata>
<dir name="C:\" date="2048-00-00 00:00:00" contains="-1">
<file name="AUTOEXEC.BAT" size="0" modified="2000-04-03 13:51:04" attr="a"/>
<file name="BOOT.INI" size="288" modified="2000-04-03 15:14:38" attr="rsa"/>
<file name="sd_settings.ini" size="462" msdos="SD_SET~1.INI" modified="2001-
06-14 09:08:44" attr="a">
<verinfo name="DOS 8.3 Name" value="SD_SET~L.INI"/>
</file>
</dir>
</filedata>
<storedfiles>
<storedfile type="storedfile" name="SYSTEM.INI" size="217" istext="1"
istruncated="0" dir="C:\WINNT\SYSTEM.INI">
<contents encoding="text">; for 16-bit app support
[386Enh]
woafont=dosapp.fon
EGA80WOA.FON=EGA80WOA.FON
EGA40WOA.FON=EGA40WOA.FON
CGABOWOA.FON=CGABOWOA.FON
CGA10WOA.FON=CGA40WOA.FON
[drivers]
wave=mmdrv.dll
timer=timer.drv
[mci]
</contents>
</storedfile>
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</storedfiles>
</inventory>

An explanation of the <applicationdata> element

In an enriched XML scan file, the <applicationdata> section contains a list
of applications identified on the computer along with the version IDs.

<applicationdata>

<application version="6.0 sp1"
release="6.0"
name="Internet Explorer"
desc="Microsoft Internet Explorer"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Web Browsers"
maindir="C:\Program Files\Internet Explorer"
lastUsed="2004-05-05 00:00:00"
versionid="12790"
releaseid="131"

/>

<application version="6.0 sp1"
release="6.0" name="Outlook Express"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Communications"
maindir="C:\Program Files\Outlook Express"
lastUsed="2004-05-05 00:00:00"
versionid="12792"
releaseid="372"
licencedby="12790"
licencedbyrelease="131"

/>

/applicationdata>
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The example above could be found for a machine with just two applications
on it: Microsoft Internet Explorer and Microsoft Outlook Express. The
“licencedby” attribute indicates that Microsoft Outlook Express is licensed
by Microsoft Internet Explorer. In other words, while both are licensable
applications, this machine requires 1 licence for Microsoft Internet Explorer
- with this licence, no separate Outlook Express licence is required.

Launching the XML Enricher from the appliance

The XML Enricher is a pre-installed service. The service is enabled by default
on the appliance and will start processing scan files as soon as the Network
Configuration has been configured and activated.

Starting and stopping the XML Enricher service

You must make sure that the XML Enricher is started and

configured if you want application data to be added to your scan
files.

You may sometimes want to stop and start the XML Enricher service
manually.

To manually start or stop the xml enricher service:
1 Click Administration > System Preferences > Appliance Services.

2 Scroll down to the XML enricher entry.

FML enricher enabled: & Default Yes
© Custom: & Yes € No

3 Click Yes to start the service, or click No to stop the service.

4 Click Change to activate the desired state.
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Configuring the XML Enricher on the appliance

You can configure the following options to control the XML Enrichment
process:

Application Recognition
Generate MIF Files
Automatically Defer All New Scans

m Merge Priority

To configure the XML Enricher on the appliance:
1 Click Administration > System Preferences > Scanned Devices.

2 Set the options as required. They are described below.

Application Recognition: © Default: All Files
@ Custom: © Al Files
& Only Exacutable Files
© Mo Application Recognition

Generate MIF fileg © Default Never

»

Custom: @ Always
© MNever
© When SMS 15 detected

Automatically defer all new scans: © Default Na

Custom: & Yes © No

Default. BIOS asset tag
BIOS serial number

MetBIOS name and YWindows domain
WAC Address

O]

Merge priority

Asset tag
Scan filename
« Custorn Selected [ Order |

BIOS assat tag

Add== BIOS serial number Ilove: LUp

NetBIOS name and Windows domain
MAC Address

Asset tag
“<Rermove Scan filenarne flaye D
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Application Recognition

There are three options for Application Recognition:

Option Description

All Files All files are sent to the recognition engine
for processing. This is the default option.

Only Executable Files Only executable files are sent to the
recognition engine for processing.

No Application Recognition No files are sent to the recognition engine
for processing.
In this state, no <applicationdata> section
will be added to the scan files.

Generate MIF Files
There are three options for Generating MIF Files:

Option Description

Always The XML enricher will always produce
MIF files from scan files.

Never The XML enricher will never produce
MIF files from scan files. This is the
default option.

When SMS is detected Only scan files with a value in the
hwOSMIFPath field will cause a MIF file
to be produced (i.e. computers where the
SMS client is installed).

Automatically Defer All New Scans
If enabled, the following happens when a scan file is found in incoming:

m The scan file is looked up in the internal database (Not the Inventory
Database).
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m [fthe machine has never before been scanned, the scan file is not processed
or enriched. Instead, it is moved to the deferred/firstscan directory.

m If the machine has been scanned before, the enricher checks if there is a
scan file with the same name in the deferred/firstscan directory. If there is,
the old scan in the deferred/firstscan directory is deleted and is replaced
with the new one.

When a new computer is scanned for the first time, the data is not added to
the database until it has been manually reviewed and the scan file has been
moved back to the incoming directory.

Merge Priority

This allows you to define what to use as the primary data merge keys. It is
only used when scan files are placed in the incoming directory. If the
Scanners are automatically launched then this is not necessary.

For example, if NetBIOS Name and Windows Domain are chosen (both
Desktop Inventory and Network Discovery can detect these), then it will use
this information in the scan file to find the matching device in Network
Discovery.

If this was not done, then the Desktop Inventory scans would create new
devices or be merged with the wrong data.

AutoSequence Number

The AutoSequence Number commands will help you assign an automatically
generated number to your scan files. This feature is optional, but will be
helpful if you want to assign numbers to your scanned workstations. If you
enable this function, each new scan file will be given a
“hwAutoSequenceNumber” field that will contain this automatically
generated number. You can use these options to determine the format of the
number.

Note: If you are using aggregation, you should assign unique sequences to
every Peregrine appliance in your network. If one asset is being monitored
by two appliances, the sequence number from one appliance will be visible
on the other.
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The Prefix can be an alphanumeric string (valid characters are A-Z, a-z, 0-9,
dash, and underscore).

Note: There must be a prefix configured.

The Character Count determines how many digits will be in the
AutoNumber.

The Next Number will be the number at which the Auto-generator will start.
For example, if you enter “17, the first asset number will be 0001.

Note: If you enter a Next Number that is more digits than configured in the
character count, the character count will automatically change to
accommodate.

To configure AutoSequence numbers
1 Click Administration > System Preferences > Scanned devices.

2 Enter a Prefix, Character Count, and Next Number.
3 Click Change.

AutoSequence Number

AutoSequence prefix € Default

@ Custom [PRGN |
AutoSequence character count:  © Default S

& Custorn: ;|
AutoSequence next number: © Default: 0

@ Custom [10645 |

Change |

The example above would
produce the following number:
PRGN0010646
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Managing Scan Files

You can configure the following options to control scan file management:
m Delete Orphaned Scan Files

m Group Processed Scan Files

To configure scan file management:
1 Click Administration > System Preferences > Scan file management.

2 Set the options as required. They are described below.

Delete orphaned scan files: © Default: Always
& Custom: & Always
© On purge
© Mewar

Group Processed Scan Files

Default:
Custom: [hwHostOS

s 0

Default: unknown
Custom: Junknown
Default

Custorm; |

Group processed scan files primary blank:

s 0

o)

Group processed scan files by secondary:

(..
Group processed scan files secondary blank: & Default unknown

€ Custom: funknawm
Group processed scan files by tertiary: @« Default:

€ Custom: |
Group processed scan files tertiary blank: & Default: unknown

]

Custom: Junknown

Change |

Delete Orphaned Scan Files

Orphaned scan files are scan files that are no longer associated with a network
device.
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There are two scenarios that create orphaned scan files:
m The network device has been purged from the database.

® Anadmin user has changed the scan file groupings, so the original scan file
is orphaned, while new scan file for that device is located in another folder.

You can use this feature to have Network Discovery automatically delete
these orphan scan files.

Group Processed Scan Files

The grouping commands will help you organize your scan files in the
processed directory. You can group your scan files based on Hardware Fields
(for a complete list, see Help > Classifications > Hardware Fields).

The value of the selected hardware field will be used as the name of a
subdirectory under the “processed” directory.

If the Hardware field you have chosen is blank in a scan file, that file will be
moved to a “Blank” directory.

Updating the application library used by the Enricher

When you want to update the application library, do the following:
1 Copy the user SAI files to the /sai directory on the network share.

Note: The master.sai is automatically used from the sai8.apm package

2 In Network Discovery, click Administration >Data Management > Validate
SAL

3 Click Validate.

The enricher automatically finds and loads all SAI files located in the /sai
directory when restarted.
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Error messages

The following table shows the possible error messages you may come across
and what they mean.

Error message Meaning

A ReadOnly SATisnot  This happens if both a Read Only SAT and a Master SAI
allowed together with ~ and/or National SAI is found
master and national

SAls

This file does not match This happens if Master/National SAIs with different
the time stamp of the timestamps are found.

other master or national

SAI files

This SAI type is not The type of SAI file is not allowed. Not relevant for this
allowed here release.

The <filename> is not a If a file is not a valid SAI file.

valid SAI
No SAI files found No SAI files were found in the /sai share.
Too many SAI sets to There is a limit to the number of SAI sets that can reside

add a new one. Delete  in the \sai directory. This limit is 10 sets.

some SAI sets. Note: A set of SAIs consists of a group of SAI files you

want to use together.

If this limit is exceeded them this error message is
displayed. You will have to delete a set of SAIs on the
Manage SAI page:

(Administration > Data Management > Manage SAI).

No new SAI to validate. A new SAI has not been found in the \sai directory.
Use ApE to create new

SAI files and upload to

the \sai directory.

Cannot copy file The file could not be copied.

Invalid name. Valid The file name uses invalid characters.
characters are a-z, A-Z,
0-9 and underscore.

Invalid name. The file name is too long.
Maximum length is 20

characters.

SAI set named <sai The file name is already in use.

name> is already in use.
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Error message Meaning

Cannot create directory The directory name cannot be created.
<dir name>

“Cannot copy file <file  The file could not be copied.
name>
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CHAPTER

Scanner Generator

In this chapter you will find information on the following topics:

m [ntroduction to the Scanner Generator when being used with Network
Discovery on page 78

m The Scanner Generator pages on page 80

m Differences in the Scanner Generator pages when in appliance mode on
page 82
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Introduction to the Scanner Generator when being
used with Network Discovery

The Scanner is configured and generated in Scanner Generator according to
the specifications determined in the planning stage of the inventory. Then
the Scanner is run across the computer population to collect inventory data,
automatically using the scheduling mechanism on the appliance.

Figure 6-1: Summary of Scanner life cycle

Automatic/
Appliance

—

Configuration file

Fixed Scanner

Scanner
Generator

Manual

—>

Customize Scanner

Configured
Scanner
Executable

The components of a Scanner

A Scanner consists of two files:

Run on computer

m The Scanner executable file

Output file

Scan files

This file is an executable file. It contains the constant parts of the Scanner:

= strings
= bitmaps

database files

= the Scanner executable code

= plug-ins

m The Scanner configuration file
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The configuration file is a binary file containing the settings for the
Scanner you are currently configuring.

When the Scanners are used in the appliance mode, they read the
configuration from a separate configuration file. This is a binary file with
a .cxz extension. The typical size of the configuration file is about 3K. As
the size of the configuration file is significantly smaller than the size of the
complete Scanner, a separate Scanner configuration is useful for repetitive
inventory collection when the configuration of the Scanner has been
altered. In this case only a small configuration file is delivered to the user’s
computer to run with the original Scanner instead of delivering the entire
new Scanner.

The self-contained Scanner executable

When used in stand-alone mode, the Scanner Generator generates self-
contained Scanner executables that consist of a combination of the two files
listed above.
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The Scanner Generator pages

The Scanner Generator is composed of a succession of pages. Each of these
pages displays information or requires user input, such as selection of
options or entry of data items.

There are two scenarios in which the Scanners can be used. This is

determined on the first page of the Scanner Generator. Depending on which
of these scenarios you select, different tab pages are displayed.
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Scenario Page Select method for inventory implementation

Using Network Discovery with Desktop Inventory and Desktop Administration

| Appliance Location Page Set up where the appliance is located and which configuration to use.

! Collection Page Select data types to collect

Hardware Data Page Disable unwanted hardware scanning routines

Software Data Page
Select software setup mode:
Targeted directory Scan
Classic Local Drive Scan

Asset Data Page

Set up a user entry form,
refilling and asset number
options

Drives Tabh
Select a pre-defined set of
drives to scan

Drive Selection Tab
Select detailed options for
drives

Directories Tab
Select directories to scan

File Scanning Tab
Select level of file detail
for data collected

Stored Files Tab
Select stored file data to
collect

Plug-Ins Tab
Select plug-in data to

Scanner Options Page
Set up saving and Ul
options, error messages
and Scanner behavior.

User Entry Tab
Create asset questionnaire

Refilling Tab
Set options for data refilling

Asset Number Tab

Set options for asset number
and creation of asset number
batch file.

Scanner To Generate Page
Select which Scanners to
generate and storing options

Saving Tab

Set default scan file format.
User Interaction Tab
Define how the Scanner
interacts with the user.

GUI Options Tab

Specify which pages will be
visible to the user, and the
Scanner mode.

Errors Tab
Set up customized error

messages and save to a log
file

Generate Scanner
Configuration

Output Options Tab
Set a Scanner description and output format

DOS Options Tab
Set options to control the
behavior of the DOS Scanner

Appliance Tab

Set up how Scanner
should behave when it is
launched from appliance
and no user is logged in to
target machine

Virtual Machines Tab

Set options to terminate the
Scanner if it is running inside
a virtual machine.
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Differences in the Scanner Generator pages when in
appliance mode

When you select the option the work in appliance mode, some parts of the
Scanner Generator User Interface change. This section highlights those
changes. For comprehensive information on the whole of the Scanner

Generator User Interface refer to the Desktop Inventory Users Guide. Only
changes from Stand-alone Desktop Inventory have been shown here.

The scenario page

On starting the Scanner Generator, the Scenario page appears.

» Select the Desktop Inventory using Peregrine appliance option.

ﬂ.Scanner Generator ﬂ
Scenario -
Chooze the method that will be used to implement the Peregrlne
imventory. SYSTEMS.

Select the scenario in which the scanner will be used. Click Mext to continue.
{* Desktop Inventary using the Peregrine Appliance

Thiz default option should be used to automatically collect an inventory uzing scheduling and
launching on the Peregrine Appliance.

Ir thiz mode, several options will be preconfigured to facilitate seamless integration between the
Appliance and the Scanners. Some of theze options will be greped out to indicate that they cannot
be changed.

= Stand-Alone or Manual Inventary

Chooze thiz option if the Peregrine Appliance will not be used to schedule the scans, for example if
the scanz will be launched from login scriptz or on non-networked machines.

Help | < Back | Mest » | Cancel I

This option should be used to automatically collect an inventory using
scheduling and launching on the appliance.

In this mode several options in the Scanner Generator have been
preconfigured to facilitate the interoperability with between the Scanners
and the Peregrine appliance. Some options will be greyed out to indicate they
cannot be changed.
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The Appliance Location page

This page will appear if you selected the Desktop Inventory using the
Peregrine Appliance option on the Scenario page.

This page is used to set-up the appliance location and the configuration to be
used for creating the Scanner file.

ﬂ.Scanner Generator ﬂ
Appliance Location -
‘wihere is the appliance, and which configuration should Peregrlne
be uzed? SYSTEMS.

Set up the IP Address of the Peregrine Appliance and the scanner configuration file to use, then click
Mext.

1P Address of the Peregrine Appliance User Mame Password
[17222542 Juser]

{* Use Default Scanner Configuration
[~ Enable scanning of java class files

" Load Scanner Configuration File

| =l

Help | < Back I Mest » I Cancel

To set up the appliance location:
1 Enter the IP address of the appliance.

2 Enter the User Name and Password to access the appliance. The User Names
and Passwords are defined when the administrator sets up the accounts on
the appliance.

Note: The Scanner Generator automatically maps the share
“\<Appliance_IP_Address>\share”. No drive letter is used for this
mapping. The mapping will remain active even when the Scanner
Generator is exited. If this is not desirable you can use the Windows
Explorer’s Tools > Disconnect Network Drive menu command to
disconnect from the appliance after terminating the Scanner
Generator.

3 Select one of the following configuration sources:
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a Use default Scanner configuration
Uses default configuration settings for the Scanner.
b Load Scanner configuration File

Reads the settings from a previously saved external configuration file
(.cxz). This file contains the configuration settings only from a previous
Scanner. Typically this file is 3 KB in size.

Click the 2 button and navigate to the configuration file stored on alocal
disk drive or network drive.

You can drag and drop a configuration file onto this page of the Scanner
Generator to automatically load the settings from that file. The path to the
file will be shown in the field here.

4 Click the Next button to continue to the Collection page.

When the Next button is clicked, the Scanner Generator verifies that an
appliance is available at the specified IP address. If not, an error message is
displayed.

° Cannot access IP Address 172,22.5.34,

Flease verify that the IP Address specified for the Peregrine Appliance is correct before proceeding,

The Standard Configuration page

This page is displayed if you selected the Stand-Alone or Manual Inventory
option on the Scenario page.
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The Collection page

The Collection page is used to select the computer data to be collected.

ﬂ.Scanner Generator ﬂ

Collection .
what data do pou want to collect? & Peregrln

SYSTEMS.

Check the options below, and press Nest to continue.

¥ Hardware and Configuration

Select thiz option to detect information about installed hardware, how the
hardware iz configured, which operating spstem is installed and how the
operating spstem has been configured faor the cument uzer,

¥ Software Data
Select this option to zcan and store information about files and directories
ot the machine or accessible to users of the machine.

¥ Asset Data

Select this option to collect data that cannaot alwayps be detected
automatically.

Help | < Back I Mest » I Cancel |

For inventories configured to use the appliance, the hardware option is
always selected and cannot be disabled as shown in the screen shot above.
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The Software Data page

The Software Data page is used to select the software scanning method.

ﬂ.Scanner Generator i ll
Software Data -
‘which scan method should be used? Peregrlne
SYSTEMS.

Select software scanning mode, and then click Mext.

{+ Targeted Directory Scan

Select this option for optimum scanning speed and software licence accuracy.
Only directories pointed ta by Windows shortcuts or present in the PATH are
scanned.

(" Classic Local Drive Scan

Select this option to perform a complete scan of all local non-removable drives.
Thiz option takes slightly longer to complete and should be used when
performing a forensic scan.

T Combined Scan
Select this option to doboth of the above: scan all local hard disk dives as
welllaz directaries on the network pointed ta by shortcuts or BATH.
This option is disabled

for app”ance inventories Allow scanner command line to overide this selection

Help | < Back I Mest » I Cancel

Combined Scan
Note: This option is disabled for appliance inventories.

The Refilling tab

In Desktop Inventory using the Peregrine Appliance mode, the Scanners
only save a local scan file, and this file is always used for refilling.

The Asset Number tab

The Asset Number tab is used to set options for managing the asset number
used to uniquely identify a computer.
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The Scanner Options page

The Scanner Options page is used to set options for controlling the behavior
of the Scanner during the usual scanning process and under exceptional
conditions, as well as options for saving the inventory results.

ﬂ Scanner Generator (%]

Scanner Options -
where should the scan file be saved? How should the scanner Peregrln

behave when running? SYSTEMS

Saving | Uzer Interaction | GUI Dptionsl Errars I Dos Dptionsl irtual Machinesl

Define which scan files should be saved, and where they should be saved.

Default scan file format
’V = Compressed ©ML [.xsf) |

P
Save Az File Path/URL
¥ Use IrfiTool.ini file to store scan information " File Ihﬂp:J’J’<applianc:e:.hm.l’sc:annerm;aloadscans
¥ Save result lacally CIFTR Lser Name Password
¥ Enable delta scan files Imyuser I ********

¥ Save result to netwark [off-site] 0k I Cancel

PC Save Path I\\SEHVEH\Idd r

UNIX Save Path |/tmp e |

I~ Allow users to change the offsite save location on eror

Help | < Back | Mest » Cancel

The Saving tab

The Saving tab page is used to set options for saving the inventory results.

This is the location where you can enable/disable the delta scanning feature
(by default, it is disabled).

Special Case: Using Delta Scanning with UNIX Scanners

There are no Listeners available for UNIX. Therefore, if you want to use delta
scanning with your UNIX devices, you must configure access to the

Peregrine appliance over HTTP, and use a script to check and transmit scan
file data.

In order to work properly, the scanner must be able to compare the scanfile
ID on the Peregrine appliance with its own scanfile ID. If both scan files have
the same ID, the scanner can then send the delta data to the Peregrine
appliance.
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First you must set up the Scanner Options page with the correct data. Then,
you must use a script to run when doing your delta scanning.

Set up Scanner Options

1 Select Enable delta scan files.

2 Select Save result to network (off site).

3 Click the Advanced button next to UNIX Save Path.
The Advanced Settings dialog appears.

4 Under Save As, select HTTP.

5 Under File Path/URL, enter http://<appliance>/nm/scanner/uploadscans
<appliance> is the IP address of your Peregrine appliance.

6 Enter the user name and password that you created in Step 4: Add a Scanner
Account on the appliance (optional) on page 36).

7 Click OK.

8 To continue with the Scanner Generator, click Next.

To set up a script
1 You must use a script that calls for the scan file ID at the following URL:

http://<appliance>/nm/scanner/getscanid.pcgi?AssetTag=<asset_tag>

2 You can download a script from the Download directory on the Peregrine
appliance. Click Download > deltascan.pl.
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The Appliance tab

The Appliance tab is used to choose how the scanner should behave when it
is launched from the appliance and no user is logged in to the target machine.

ﬂ.Scanner Generator ﬂ

Scanner Options -
where should the scan file be saved? How should the & Peregrlne

zcanner behave when wnning? SYSTEMS

Saving | User Interaction | GUI Dptionsl Ermors I DOS Options ~ Appliance |VirtuaIMachines|

Select the action to perform when no uger iz logged inta the computer [win32)

Actior
{* Scan immediately
= Wwait until someone logs in

" Exit the scanner

Help | < Back I Mest » I Cancel |

To define the behaviour of the Win32 scanner when no user is logged in,
select one of the available options:

1 Scan Immediately

No special action is taken by the scanner. Note that the information collected
will be limited by the fact that no user is logged in.

2 Wait until someone logs in

The scanner sleeps until a user logs in to the machine, at which point the
scanner scans the machine. Full information can be collected by the scanner.

3 Exit the scanner

The scanner terminates and does not collect a scan file.
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The Scanners To Generate page

The Scanners to Generate page is used to specify which Scanners to generate
and where they should be stored.

The Output Options tab

The Output Options page is used to set up Scanner descriptions, save the
configuration to a text file if required and for appliance based inventories
only, the option to name the configuration (.cxz) file.

Note: The configuration file is saved on the appliance as well, using the same
file name as the copy specified here.

The Generating Scanners page

Once you have selected the Scanners to be generated and have clicked the
Generate button, the last page of the Scanner Generator is displayed.

Now that you have generated Scanner configuration files for the Scanners
you want. These will now have to be validated for use on the appliance.

This is necessary to ensure that the configuration options chosen are
compatible with scanners being deployed automatically.

To validate a scan configuration:
1 Choose the name of the configuration file from the drop-down list.
2 Click Validate.

If the configuration is valid, a message The configuration is now in use is
shown.

If you selected the Desktop Inventory using the Peregrine Appliance option
on the first page of the Scanner Generator, then the following screen will be
displayed when the Scanner configuration file has been created and copied to
the appliance.
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Note: Only a configuration file is created for an appliance mode inventory.

'ﬂ_.Scanner Generator ﬂ
Generating Scanners -
The requested scanners are being generated. K‘ Peregrlne
SYSTEMS.
LogTime | Log keszage |
@ 2004/06/09 14:41:27 Scanner Generator started
@ 2004/06/09 14:44:25 Generating Configuration File C:\Program Filesh...
@ 2004/06/09 14:44:25 Configuration file created
@ 2004/06/09 14:44:25 Copying Configuration File to appliance at 172.2...
@ 2004/06/09 14:44:27 Configuration file copied to appliance
@ 2004/06/09 14:44:27 Finizhed.

Mote: A new Scanner Configuration has been copied to the Peregrine Appliance. This
configuration file will not be uzed until it has been verified and configured.

To configure the uge and distribution schedule for this configuration, click here.

Help | < Back I FEinish I Cancel |

If the Scanner configuration cannot be copied to the appliance for some
reason, an error message is displayed in the log and the bottom panel does
not appear.

In this case, check that you have write access to the share directory on the
target appliance. It may also occur if another scan configuration with the
same name already exists on the appliance.

Right-clicking anywhere in the log window displays a shortcut menu which
allows you to:

m Save the contents of the window to a log file.
m Copy the contents of the log window to the clipboard.

m Clear the log window.
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1 Click on the hyperlink to access the appliance web pages to configure the use
and distribution schedule for this configuration. The following web page is
displayed.

Validate Scanner Configuration

Mew scan confipuration files available:

scan ¥

Yalidate |

Heorne = Administration = Data = Validate Scanner Configuration

2 Select the Scanner configuration file that you have just generated from the
pull-down list. In this example the configuration file was called scan.

3 Click the Validate button.

If the scanner configuration already exists, you will be presented with the
following screen.

4 Click the Continue button if you want to replace the Scanner configuration.

What happens if the file is not valid

The following table lists the possible error messages you may encounter when
validating a Scanner configuration file:

Error message Explanation

File is not a scanner configuration file; The file type is not a Scanner

cannot read configuration file (.cxz).

Hardware detection is disabled The Scanner configuration file has been

created with hardware detection disabled.
For a Scanner configuration file to be
valid, hardware detection must be
enabled.

Network detection is disabled The Scanner configuration file has been
created with network detection disabled.
For a Scanner configuration file to be
valid, network detection must be enabled.
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Error message Explanation

Local FSF save is disabled The Scanner configuration file has been
created with the Local FSF save setting
disabled. For a Scanner configuration file
to be valid, this setting must be enabled.

Use of InfrTool.ini is disabled The Scanner configuration file has been
created with the InfrTool.ini setting
disabled. For a Scanner configuration file
to be valid, this setting must be enabled.
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